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Вводная часть 

Описание руководства 
Назначение 

руководства 

Данное руководство предназначено для научных сотрудников и 
другого персонала лаборатории, планирующих использовать прибор 
Applied Biosystems 7300/7500 Real Time PCR (прибор 7300/7500) для 
проведения  анализа в режиме плюс/минус (+/-). 

Квалификация 

пользователя 

Требования к пользователям прибора: 

• Опыт работы с операционной системой Microsoft Windows 
XP. 

• Опыт работы в области выделения и очистки препаратов ДНК 
и их подготовки для проведения ПЦР. 

• Общие представления о хранении данных на жестких дисках, 
перемещении файлов, копировании и вставке фрагментов 
текста. 

При необходимости интегрировать прибор 7300/7500 в 
существующую в лаборатории систему потока данных, необходим 
опыт работы с компьютерной сетью. 

Условные 

обозначения, 

используемые в 

данном 

руководстве 

В данном руководстве используются следующие условные 
обозначения: 

• Жирный шрифт указывает на необходимость определенных 
действий пользователя. Например: 

Ввести значение 0 и нажать на клавишу Enter (ввод) для 
перехода в остальные поля данных. 

• Курсив означает новые или важные слова, а также 
используется для привлечения внимания пользователя. 
Например: 

Перед началом анализа всегда следует готовить свежий 
образец матрицы. 

• Правая скобка - стрелка (>) разделяет последовательные 
команды, которые пользователь выбирает из ниспадающего 
меню или меню быстрого доступа. Например: 

Выбрать опцию File (файл) > Open (открыть) > Spot Set 
(определить ячейку).  

Слова, 

используемые  

для привлечения 

внимания 

пользователя 

В данном руководстве по эксплуатации прибора фирмы Applied 
Biosystems для привлечения внимания пользователя используются 
два типа слов. Каждое слово означает особый уровень внимания или 
действия пользователя, как описано ниже: 
Примечание:   Информация представляет определенный интерес и может 
быть полезна, однако, не является необходимой информацией при 
эксплуатации прибора. 
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ВАЖНО!   Данная информация необходима для правильной эксплуатации 
прибора, безопасного использования наборов химических реактивов или 
отдельных реактивов. 

Техника 

безопасности 

Основные правила техники безопасности приведены в руководстве 
по подготовке к установке и техническому обслуживанию прибора 
7300/7500 (Applied Biosystems 7300/7500 Real Time PCR System 
Installation and Maintenance Getting Started Guide, номер по каталогу 
4347828) и в руководстве по подготовке рабочего места для прибора 
7300/7500 (Applied Biosystems 7300/7500 Real Time PCR System Site 
Preparation Guide, номер по каталогу 4347823). 

Получение дополнительной информации 

 Подробная информация по эксплуатации прибора 7300/7500 
приведена в следующих руководствах: 

• Applied Biosystems 7300/7500 Real Time PCR System Online Help 
(оперативная помощь к прибору 7300/7500 Online) 

• Applied Biosystems 7300/7500 Real Time PCR System Allelic 
Discrimination Getting Started Guide (руководство по 
подготовке к выполнению анализа по распознаванию аллелей 
на приборе 7300/7500) (номер по каталогу 4347822) 

• Applied Biosystems 7300/7500 Real Time PCR System Absolute 
Quantification Getting  Started Guide (руководство по 
подготовке к выполнению абсолютного количественного 
анализа на приборе 7300/7500) (номер по каталогу 4347825)  

• Applied Biosystems 7300/7500 Real Time PCR System Relative 
Quantification Getting Started Guide (руководство по подготовке 
к выполнению относительного количественного анализа на 
приборе 7300/7500) (номер по каталогу 4347824)  

• Applied Biosystems 7300/7500 Real Time PCR System Installation 
and Maintenance Getting Started Guide (руководство по 
подготовке к установке и техническому обслуживанию 
прибора 7300/7500) (номер по каталогу 4347828)  

• Applied Biosystems 7300/7500 Real Time PCR System Site 
Preparation Guide (руководство по подготовке рабочего места 
для прибора 7300/7500, предназначенного для проведения ПЦР 
в режиме реального времени) (номер по каталогу 4347823) 

• Sequence Detection Systems Chemistry Guide (химические 
принципы для определения последовательности нуклеиновых 
кислот) (номер по каталогу 4348358) 

 

Техническое обеспечение и помощь 

 Для получения самой последней информации о техническом 
обеспечении и помощи следует открыть сайт 
http://appliedbiosystems.com и выбрать соединение с разделом 
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технической помощи (Support). В окне Support можно: 

• Проводить поиск в окне «Search through frequently asked 
questions» (наиболее часто задаваемые вопросы) (FAQs). 

• Обратиться с вопросом напрямую в отдел технической 
помощи. 

• Заказать документацию по использованию приборов фирмы 
Applied Biosystems, спецификации по технике безопасности 
MSDS, сертификаты анализов и другую соответствующую 
документацию. 

• Загрузить файлы документов в формате PDF. 

• Получить информацию по технической подготовке 
пользователей. 

• Загрузить усовершенствованные версии программного 
обеспечения и вставки в программы. 

В окне сервис (Service) и технической помощи (Support) приведены 
так же номера контактных телефонов и факс, с помощью которых 
можно связаться со службой продаж и технической поддержки и 
торговыми менеджерами фирмы Applied Biosystems. 

Обратная связь 

 Фирма Applied Biosystems приветствует любые замечания и 
предложения пользователей, по усовершенствованию данного 
руководства. Предложения можно отправить по электронной почте по 
адресу: 

             techpubs@appliedbiosystems.com 
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Описание прибора 7300/7500 

Описание Использование в приборе Applied Biosystems 7300/7500 Real Time 
PCR (прибор 7300/7500) флуоресцентно меченных химических 
реагентов для проведения ПЦР обеспечивает: 

• Количественное определение последовательности 
нуклеиновых кислот в режиме реального времени. 

• Качественное определение последовательностей 
нуклеиновых кислот с использованием анализа конечных 
данных и кривой диссоциации. 

Анализ 

Plus/Minus 

Прибор 7300/7500 позволяет проводить несколько типов анализа с 
использованием планшетов или пробирок 96-луночного формата. 
В данном руководстве приведено описание анализа в режиме 
plus/minus (+/-), который позволяет определить наличие или 
отсутствие специфической последовательности нуклеиновых 
оснований в анализируемом образце. 
Примечание:   Более подробная информация о других типах анализа 
приведена в руководстве Sequence Detection Systems Chemistry Guide 
(Химические принципы для определения последовательностей 
нуклеиновых кислот) (номер по каталогу 4348358) и на сайте 
оперативной помощи для прибора 7300/7500 (Online Help). 

 

Краткое описание анализа в режиме Plus/Minus с 

использованием внутреннего положительного стандарта IPC 

Определение Анализ в режиме plus/minus представляет собой анализ конечных 
результатов, в ходе которого определяется наличие (+) или 
отсутствие (-) специфической последовательности нуклеиновых 
оснований в анализируемом образце. При анализе конечных 
результатов сбор данных производится после завершения ПЦР. 

Что такое IPC IPC � внутренний положительный стандарт (см. описание набора 
реагентов TaqMan Exogenous Internal Positive Control, номер по 
каталогу 4308323), который используется для анализа в режиме 
plus/minus для контроля процесса ПЦР и для того, чтобы 
убедиться, что отрицательный результат не является следствием 
ошибочных данных ПЦР. IPC включает матрицу, набор праймеров 
и меченный красителем зонд (VIC), которые добавляются в 
каждую лунку реакционного планшета (IPC является частью 
реакционной смеси, см. раздел «Приготовление реакционной 
смеси для ПЦР» на стр.17 ) 

Для анализа в режиме plus/minus с IPC используются 
флуоресцентные реагенты, содержащие 5`-нуклеазу (известные так 
же под названием зонд TaqMan). Во ходе амплификации мишень в 
образце и мишень IPC образуют репортерные флуоресцентные 
сигналы и  таким образом может быть получен положительный 
или отрицательный отклик в лунках с неизвестным образцом. 
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Примечание:   Краситель SYBR Green I не используется для 
проведения анализа в режиме plus/minus, включающем IPC. 

 

Термины, 
используемые 

при проведении 
анализа в 
режиме 

Plus/Minus 

Термин Определение 

Внутренний положительный 
стандарт (IPC) 

Второй набор зондов и праймеров 
TaqMan, добавляемый в 
реакционный планшет для 
контроля процесса ПЦР и для 
того, чтобы убедиться в том, что 
отрицательный результат не 
является следствием ошибочных 
данных ПЦР 

Контроль в отсутствии 
амплификации (NAC) 

Лунки, не содержащие мишени и 
содержащие блокированный IPC 
(мишень IPC блокирована 
блокирующим агентом) 

Контроль в отсутствии матрицы 

(NTC) 

В образце отсутствует матрица 

Мишень-нуклеиновая кислота Нуклеотидная 
последовательность, наличие или 
отсутствие которой необходимо 
детектировать 

Неизвестный образец (U) Образец, в котором необходимо 
определить наличие или 
отсутствие специфической 
последовательности нуклеиновых 
оснований 

 
 
Описание процесса анализа в режиме Plus/Minus 
Последовательность 

выполнения 
анализа в режиме 

Plus/Minus 

В контексте данного руководства термин «анализ в режиме 
Plus/Minus» означает все стадии процесса анализа образцов 
экстрагированной ДНК в соответствии с данными, 
полученными после завершения ПЦР. 

После создания параметров эксперимента и выделения ДНК 
анализ в режиме «Plus/Minus» включает следующие стадии: 

• Проведение цикла до считывания   в планшете 
«Plus/Minus» для определения величины сигнала 
базовой линии, образованного праймерами и зондами 
перед амплификацией. 

• Проведение цикла амплификации с использованием 
документа планшета AQ для сбора данных ПЦР в 
реальном времени, которые могут быть использованы 
для анализа данных ПЦР в режиме plus/minus и при 
необходимости для устранения возникших проблем. 

• Проведение цикла после считывания с 
использованием документа исходного планшета, при 
этом из полученного сигнала автоматически вычитается 
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сигнал флуоресценции базовой линии, определенный в 
ходе цикла до считывания и осуществляется обработка 
данных. 

На приведенном ниже рисунке представлены все стадии 
процесса: 

 
 

     

Поставляемые 
материалы, 

необходимы для 
анализа 

Название Фирма-производитель 

Приборы и химические реактивы 
для выделения и очистки ДНК: 

• Прибор ABI PRISM 6100 
Nucleic Acid PrepStation 

 
• Набор BloodPrepChemistry 

(геномная ДНК из свежей или 
замороженной крови или 
клеток) 

• Набор NucPrep Chemistry 
(ДНК из животных и 
растительных тканей) 

• Набор PrepMan Ultra Sample 
Preparation Reagent Kit 

 

 

• Applied Biosystems 
(номер по каталогу 
6100-01) 

• Applied Biosystems 
(номер по каталогу 
4346860) 

• Applied Biosystems 
(номер по каталогу 
4340274) 

• Applied Biosystems 
(номер по каталогу 
4322547) 

Меченые праймеры и зонды, 
производства следующих фирм: 

• Программное обеспечение 
Primer Express 
(сконструированные 
пользователем праймеры и 
зонды) 

 

 

• Номер по каталогу 
4330710 (лицензия на 1 
пользователя) 
Номер по каталогу 
4330709 (лицензия на 
10 пользователей) 
Номер по каталогу 
4330708 (лицензия на 
50 пользователей) 

Реакционный оптический 96-
луночный планшет MicroAmp 
Optical 96-Well Reaction Plate 

Applied Biosystems (номер 
по каталогу 4306757) 

Оптические адгезионные крышки 
(Optical Adhesive Cover) 

Applied Biosystems (номер 
по каталогу 4311971) 

Пробирки крышками, объемом 10 мл Applied Biosystems (номер 
по каталогу 4305932) 

Набор реагентов для внутреннего 
положительного контроля TaqMan 
Exogenous Internal Positive Control 
Reagents (VIC зонд) 

Applied Biosystems (номер 
по каталогу 4308323) 

Прибор 7300/7500 Предварительный 
цикл 

Цикл 
амплификации 

Основной цикл 
после считывания

Реакционный 
планшет 
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Набор реактивов TaqMan Universal 
PCR Master Mix 

 

Applied Biosystems (номер 
по каталогу 4304437) 

Центрифуга с приставкой для 96-
луночного планшета 

Известная фирма, 
выпускающая 
лабораторное 
оборудование (ФЛО) 

Перчатки ФЛО 

Микроцентрифуга ФЛО 

Стерильные пробирки для 
микроцентрифуги, объемом 1,5 мл 

ФЛО 

Вода, не содержащая нуклеаз ФЛО 

Наконечники для пипеток с 
фильтром 

ФЛО 

Пипетки-дозаторы вытеснительного 
типа 

ФЛО 

Буфер трис-ЭДТА (ТЕ буфер), рН 
8,0 

ФЛО 

Прибор для встряхивания и 
перемешивания Vortexer 

ФЛО 

 
 
Пример выполнения анализа Plus/Minus 

Введение В данной главе приведен пример выполнения анализа в 
режиме plus/minus  для иллюстрации создания параметров, 
выполнения анализа и анализа полученных результатов. 
Пример включает типичный анализ в режиме plus/minus, 
который может быть использован пользователем для быстрого 
начального ознакомления со схемой выполнения анализа в 
режиме plus/minus. Более подробное описание 
последовательных стадий анализа в режиме plus/minus 
приведено в следующих главах данного руководства. В каждой 
из следующих глав на специальных схемах приведено также 
подробное описание стадий анализа. 

Описание Целью данного анализа в режиме plus/minus является 
определение наличия или отсутствия специфической 
последовательности ДНК из E. сoli  в каждой партии мяса для 
гамбургеров. Эксперимент проводят в режиме 
двухкомпонентной ПЦР, т.е. в каждой реакционной смеси 
содержатся набор праймеров и меченный красителем VIC зонд 
для внутреннего положительного стандарта и набор праймеров 
и меченный красителем FAM зонд для специфической 
последовательности ДНК из E. сoli. Праймеры и зонды для 
определения ДНК из E. сoli  конструируют с использованием 
программного обеспечения Primer Express. 

В приборе устанавливают режим для проведения ПЦР с 
использованием набора реактивов TaqMan Universal PCR 
Master Mix и соответствующих праймеров и зондов. 
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Анализ в режиме plus/minus и обработку результатов 

проводятся на приборе 7300/7500, анализ включает: 

• Проведение цикла до считывания в планшете для и 
определения сигнала базовой линии, образованного 
праймерами и зондами до амплификации. 

• Проведение цикла амплификации с использованием 
документа планшета AQ для получения данных ПЦР в 
реальном времени, которые могут быть использованы 
для анализа данных ПЦР в режиме plus/minus и при 
необходимости для устранения возможных проблем. 

• Проведение цикла после считывания в исходном 
планшете, при этом из полученного сигнала 
автоматически вычитается сигнал базовой линии, 
определенный в ходе предварительного цикла, и 
определяются лунки, в которых зарегистрирован 
положительный или отрицательный отклик. 

 

Пример выполнения анализа в режиме plus/minus 

Задать параметры эксперимента и 
подготовить образец ДНК: 

1. Задать параметры эксперимента, 
как описано в главе 2. 

а. Заказать набор реактивов 
TaqManExogenous Internal 
Positive Control Reagents Kit 
и TaqMan Universal PCR 
Master Mix. 

б. Сконструировать праймеры 
и меченный красителем 
FAM зонд для определения 
специфической 
последовательности ДНК из 
E. сoli  с использованием 
программного обеспечения 
Applied Biosystems Primer 
Express. 

2. Выделить из образцов ДНК (см. 
главу «Подготовка ДНК» на стр.16 ) 
с использованием набора реагентов 
PrepMan Ultra Sample Preparation 
Reagent Kit (номер по каталогу 
4322547) и методики (номер по 
каталогу 4318925), получить 
образцы с конечной концентрацией 
ДНК в каждом образце 10 нг/мкл. 
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3. Приготовить реакционную смесь 
(см. главу «Приготовление 
реакционной смеси для ПЦР» на 
стр.17 ), как указано в приведенной 
справа таблице.  

ПРЕДОСТЕРЕЖЕНИЕ!   ТОКСИЧНЫЕ 
РЕАКТИВЫ.   Реактивы TaqMan 
Universal PCR Master Kit могут вызвать 
раздражение глаз и кожи. Не следует 
вдыхать или глотать реактивы. Необходимо 
внимательно ознакомиться с 
соответствующими спецификациями по 
безопасности (MSDS) и следовать 
приведенным инструкциям по 
использованию данных реактивов. Работать 
рекомендуется в соответствующих 
специальных защитных очках, защитной 
одежде и перчатках. 

4.   Подготовить реакционный 
планшет: 

а. Добавить пипеткой по 45 мкл 
соответствующей 
реакционной смеси в каждую 
лунку 96-луночного планшета. 

б. Добавить пипеткой 5 мкл 
блокированного внутреннего 
положительного стандарта 
IPC, ТЕ буфера или воды или 
неизвестного образца в 
соответственно отмеченные 
лунки 96-луночного планшета, 
как показано в таблице справа. 
(см. главу «Подготовка 
реакционного планшета» на 
стр. 17). 
Примечание:   Конечный объем 
реакционной смеси в каждой 
лунке должен составлять 50 мкл. 

в. До установки в прибор 
7300/7500 реакционный 
планшет необходимо хранить 
на льду.  

 

  

 

 

 

 

Компонент 

реакционной 

смеси 

Объем одной 

реакционной 

смеси 

Конечная 

конц. 

Смесь TaqMan 
Universal PCR 
Master Mix (2Х) 

25,0 1Х 

Смесь 10ХExo 
IPC Mix (IPC Kit) 

5,0 От 50 до 
900 нМ 

ДНК 

50Х Exo IPC DNA 
(IPC Kit) 

1,0 От 50 до 
900 нМ 

Праймеры для 
мишени, зонд и 
деионизированная 
вода 

14,0 От 50 до 
250 нМ 

Общее 
количество 

45,0 - 

 

 

Лунки Для 

приготовления� 

Добавить 

А1-А6 NACа 5 мкл смеси 
10X Exo IPC 
Block 

А7-
А12 

NTCб 5 мкл буфера 

 1 Х ТЕ или 
H2О 

В1-
Н12 

Uв 5 мкл 
образца, 
исследуемого 
на 
содержание 
ДНК из E. 
Coli  

а. Контроль в отсутствии амплификации � лунки 

NAC NTС плюс IPC 

Образцы (неизвестный 
образец плюс IPC) 
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Провести предварительный цикл: 

1. Создать документ plus/minus plate: 

Инструкции по созданию 
документа приведены в главе 4. 
Ниже приведено краткое описание. 
В окне New Document Wizard: 

а. Выбрать опцию File > New 
(новый файл). 

б. Выбрать в ниспадающем меню 
анализа опцию Plus/Minus 
(анализ в режиме plus/minus). 

в. В поле Plate Name (название 
планшета) ввести Plus/Minus 
Pre-Read (предварительный 
цикл анализа plus/minus), затем 
нажать клавишу Next. 

г. Добавить детекторы в документ 
о планшете (см. Приложение А, 
Определение детекторов») и 
затем нажать на клавишу Next. 

д.  Определить детекторы и тип 
детектирования для каждой 
лунки, затем нажать на 
клавишу Finish. 

е. Дважды нажать на каждую 
лунку, ввести название образца, 
затем сохранить документ. 

2. Ввести названия образцов и 
определить тип анализа в поле Well 
Inspector (View > Well Inspector). 
ВАЖНО!   Если в данном 
эксперименте используются не все 
лунки планшета, не следует 
пропускать неиспользуемые лунки на 
данном этапе. Их можно будет 
исключить  после выполнения цикла. 
Более детальная информация об 
исключении неиспользуемых лунок 
приведена на сайте оперативной 
помощи (Online Help). 

не содержат матрицы - мишени или IPC. 

б. Контроль в отсутствии матрицы � лунки не 
содержат матрицы - мишени, содержат только 
IPC. 

в. Неизвестный образец � лунки содержат смесь 
матрицы - мишени и IPC.   
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3. Запустить предварительный цикл 
анализа в режиме plus/minus. 

а. Нажать на кнопку Instrument. 
По умолчанию на экран 
выводятся стандартные условия 
проведения ПЦР. 

б. Выбрать опцию File > Save As 
(сохранить файл как), ввести 
название документа plus/minus, 
затем нажать на клавишу Save 
(сохранить). 

в. Установить планшет в прибор. 

г. Нажать на клавишу Pre-Read.    

 

 

Амплификация ДНК: 

1. Создать документ AQ Plate для 
амплификации: 

Инструкции по созданию документа 
приведены в главе 5. Ниже приведено 
краткое описание. В окне New 
Document Wizard 

а. Выбрать опцию File > New 
(новый файл). 

б. Выбрать в ниспадающем меню 
анализа опцию Absolute 
Quantification (Standard Curve) 
(абсолютный количественный 
анализ(стандартная кривая)). 

в. В поле Plate Name (название 
планшета) ввести Plus/Minus 
Amplification (амплификация в 
режиме plus/minus), затем нажать 
клавишу Next. 
Примечание:   Для 
неколичественного цикла 
амплификации стандартная кривая не 
требуется. 

г. Добавить детекторы в документ о 
планшете (см. Приложение А), 
затем нажать на клавишу Next>. 

д. Определить детекторы и тип 
детектирования для каждой лунки, 
затем нажать на клавишу Finish. 
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е. Ввести название образцов, затем 
сохранить документ.  

2. Провести цикл амплификации в режиме 

plus/minus. 

а.  Нажать на кнопку Instrument. 

б.  Выбрать опцию File > Save As 
(сохранить файл как), ввести 
название документа AQ plate, затем 
нажать на клавишу Save 
(сохранить). 

в.  Установить планшет в прибор, 
затем нажать Start. 

По умолчанию на экран выводятся 

стандартные условия проведения 

ПЦР. 

 После завершения цикла на экран 
выводится сообщение об успешно 
проведенном цикле или о 
допущенных ошибках. 

 

 

 

Выполнение цикла после считывания анализа plus/minus: 

1. Открыть документ планшета 

предварительного цикла plus/minus и 

использовать его для выполнения цикла 

после считывания. (См. раздел 

«Выполнение анализа после 

считывания результатов» на стр. 35). 

а. Нажать на кнопку Instrument.  

б. Выбрать опцию File > Save As 
(сохранить файл как), ввести 
название цикла  после считывания 
для документа plus/minus, затем 
нажать на клавишу Save 
(сохранить). 

в. Установить планшет в прибор. 

г. Нажать на клавишу Post-Read. 

д. Нажать на пиктограмму  или 
выбрать опцию Analysis > Analyze. 
Нажать на кнопку Result для 
просмотра данных для каждой 
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лунки. 

2. Если необходимо выявить и 
устранить ошибки в результатах 
анализа plus/minus, см. раздел 
«Просмотр данных амплификации» на 
стр.43. 
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Планирование анализа в 

режиме Plus/Minus 
Последовательность выполнения 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Глава 2 

 

 
Определение параметров 
анализа в режиме 
Plus/Minus 

 

Подготовка 
реакционного 
планшета 

 

Выполнение цикла 
анализа в режиме 
Plus/Minus до 
считывания 

 

Сбор данных 
амплификации 

 

 
 
Введение 
 
  

 

Использование наборов 
реактивов на основе 
зонда TaqMan 

См. стр. 13

Выбор зондов и 
праймеров См. стр. 14

 

Выполнение 
цикла Plus/minus 
после 
считывания

2 
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Использование наборов реактивов на основе зонда TaqMan 
Описание 

химических 
реагентов 

В режиме plus/minus с внутренним положительным стандартом (IPC) 
используются химические реактивы на основе флуорогенной 
5`нуклеазы известные, так же под названием химические реактивы на 
основе зонда TaqMan. 

 
Химические реакции Процесс 

Химические реактивы 
TaqMan или наборы 
химических реактивов 
TaqMan 

Описание  

В химических реакциях на 
основе зонда TaqMan 
используется флуорогенный 
зонд, обеспечивающий 
детектирование 
специфического продукта ПЦР 
по мере его накопления в ходе 
циклов ПЦР. 

Полимеризация 

 
 
Стадия 1: Репортер (R) и 
тушитель (Q) присоединены к 
зонду TaqMan в 5` и 3` 
положениях. 
 

Замещение цепей нуклеиновой 
кислоты 

 
 
Продолжение стадии 1: В 
результате присоединения 
обоих красителей к зонду 
происходит тушение 
флуоресценции репортерного 
красителя. 
 

Расщепление 

 
Стадия 2: В процессе каждого 
цикла наращивания цепи ДНК 
полимераза AmpliTaq Gold 
отщепляет репортерный 
краситель от зонда. 

 

Завершение полимеризации 

 
Стадия 3: После отделения от 
тушителя репортерный 
краситель испускает 
определенный спектр 
флуоресценции. 

 
 

 Более подробная информация о химических реагентах на основе 
зонда TaqMan приведена в руководстве Sequence Detection Chemistry 
Guide (химические принципы для определения последовательности 
нуклеиновых кислот) (номер по каталогу 4348358). 

 

Наборы 
химических 

реагентов для 
анализа в 
режиме 

plus/minus 

Для определения параметров и проведения анализа в режиме 
plus/minus фирмой Applied Biosystems поставляются перечисленные 
ниже реактивы. 

 

 

 

Прямой праймер

Обратный праймер 

R = РЕПОРТЕР 
Q = ТУШИТЕЛЬ 
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Набор реактивов Номер по каталогу 

Химические реактивы с внутренним 
положительным контролем TaqMan Exogenous 
Internal Positive Control и универсальная смесь 
для ПЦР TaqMan Universal PCR Master Mix. 

4308323 

Универсальная смесь для ПЦР TaqMan 
Universal PCR Master Mix 

4304437 

Примечание:   Содержащиеся в наборах реактивов ДНК внутренний 
положительный контроль, праймеры и зонды, могут быть использованы со 
всеми системами мишеней. Более подробная информация по оптимизации 
амплификации мишеней приведена в руководстве TaqMan Universal PCR 
Master Mix Protocol (методика по приготовлению реакционной смеси 
TaqMan Universal PCR Master Mix) (номер по каталогу 4304449). 

Выбор зондов и праймеров 
 Для каждой анализируемой последовательности-мишени следует 

выбрать набор зондов и праймеров. Фирма Applied Biosystems 
предлагает для этого программное обеспечение Primer Express. Более 
подробная информация об использовании данного программного 
обеспечения приведена в руководстве по использованию 
программного обеспечения Primer Express Software v2.0 User Manual 
(номер по каталогу 4329500). 

 

  
 

В данном эксперименте из 84 партий мяса для гамбургеров была выделена ДНК и полученные 
образцы исследовали на наличие ДНК из E. coli путем анализа в режиме plus/minus на приборе 
7300/7500 Real Time PCR. В цикле использовали шесть образцов, не содержащих внутренний 
положительный контроль и контроль в отсутствии матрицы, шесть образцов, содержащих 
внутренний положительный контроль и не содержащих контроль в отсутствии матрицы, и 84 
неизвестных образца. 

Для данного эксперимента использовали набор химических реактивов TaqMan Exogenous Internal 
Positive Control Reagent Kit: одна пробирка объемом 1 мл, содержащая 105 Exo IPC Mix. Эта смесь 
содержит праймеры IPC и меченный красителем VIC зонд. Набор праймеров и зонда для определения  
ДНК из E. coli  сконструирован с использованием программного обеспечения Primer Express фирмы 
Applied Biosystems и содержит меченный красителем FAM зонд и краситель TAMRA в качестве 
тушителя. 

 

Пример эксперимента 



 



Руководство по подготовке к выполнению анализа в режиме Plus/Minus на приборе 7300/7500           
 

15

 Подготовка 
реакционного планшета 
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Выполнение цикла 
анализа в режиме 
Plus/Minus до 
считывания 

 

Сбор данных 
амплификации 

 

 
 
Введение 

 

Выполнение 
цикла Plus/minus 
после 
считывания

Подготовка образцов 
ДНК См. стр. 16

Подготовка 
реакционного планшета См. стр. 17

 

Планирование 
анализа в режиме 
Plus/Minus 

 

 
Подготовка 
реакционного планшета 

Глава 3 

3 
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Подготовка образцов ДНК 
Системы и 
химические 

реактивы для 
выделения ДНК 

Фирма Applied Biosystems поставляет несколько систем и наборов 
реактивов для выделения ДНК из разнообразных источников, таких 
как кровь, ткани, клеточные культуры, растения и пищевые 
продукты. 

Система Номер по каталогу 

Химические реактивы BloodPrep  4346860 

Химические реактивы NucPrep 4340274 

Набор реактивов PrepMan Ultra Sample 
Preparation 

4322547 

ABI PRISM 6100 Nucleic Acid PrepStation. 6100-01 

Более подробная информация приведена в: 

• DNA Isolation from Fresh and Frozen Blood, Tissue Culture Cells, 
and Buccal Swabs Protocol (Методика выделения ДНК из 
свежей и замороженной крови, культур тканей и клеток и 
мазков из ротовой полости) (номер по каталогу 4343586) 

• NucPrep Chemistry Isolation of Genomic DNA from Animal and 
Plant Tissue Protocol (Методика выделения геномной ДНК из 
тканей животных и растений) (номер по каталогу 4333959) 

Качество ДНК К препаратам ДНК, используемым для выполнения анализа в режиме 
plus/minus, предъявляются следующие требования: 

• Величина отношения поглощения при 260 нм к величине 
поглощения при 280 нм (А260/280) должна превышать 1,7. 

• ДНК должна быть выделена из исследуемых необработанных 
материалов оптимизированным методом. 

• ДНК не должна содержать ингибиторов ПЦР. 

• ДНК должна быть цельной по данным электрофореза в геле. 

• ДНК не должна подвергаться нагреванию выше 600С, так как 
это может привести к ее расщеплению. 

 

  

Образцы мяса замораживают с помощью жидкого азота и растирают в порошок в предварительно 
охлажденной ступке охлажденным пестиком. ДНК выделяют с использованием набора реагентов 
PrepManUltra Sample Preparation Reagent Kit (номер по каталогу 4322547) и методики (номер по 
каталогу 4318925). Конечная концентрация составляет 10 нг/мкл ДНК в каждом образце.  

 

 

 

Пример эксперимента 
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Подготовка реакционного планшета 
 В данном разделе описана загрузка образцов и реакционной смеси в 

реакционный 96-луночный планшет для выполнения анализа в 
режиме plus/minus. Реагенты, объемы и конечные концентрации в 
разделе «Приготовление реакционной смеси для ПЦР» на стр. 
приведены в соответствии с методикой TaqMan Exogenous Internal 
Positive Control Reagent Protocol (номер по каталогу 4308323). 

 

  

Полученные образцы ДНК добавляют с помощью пипетки в 96-луночный планшет, в который также 
добавляют положительный и отрицательный контроли. Лунки А1-А6 содержат блокированный IPC и 
не содержат матрицы-мишени, лунки А7-А12 содержат матрицу IPC (IPC+), но не содержат матрицу-
мишень, лунки В1-Н12 содержат и IPC и матрицу-мишень. 

 

 

 

 
Приготовление реакционной смеси для ПЦР 

1. Приготовить реакционную смесь в 
объеме, достаточном для добавления 
по 45 мкл смеси в каждую лунку 
планшета. 
ПРЕДОСТЕРЕЖЕНИЕ!   
ТОКСИЧНЫЕ РЕАКТИВЫ.  
 Реактивы TaqMan Universal PCR 
Master Kit могут вызвать раздражение 
глаз и кожи. Не следует вдыхать или 
глотать реактивы. Необходимо 
внимательно ознакомиться с 
соответствующими спецификациями по 
безопасности (MSDS) и следовать 
приведенным инструкциям по 
использованию данных реактивов. 
Работать рекомендуется в 
соответствующих специальных 
защитных очках, защитной одежде и 
перчатках. 

Компонент 
реакционной 

смеси 

Объем 
для одной 
реакции 

Конечная 
концентрация

Смесь TaqMan 
Universal PCR 

Master Mix (2×) 

25,0 1Х 

Смесь 10Х Exo 
IPC Mix (IPC kit) 

5,0 От 50 до 900 
нМ 

Смесь 50Х Exo 
IPC DNA (IPC kit) 

1,0 От 50 до 900 
нМ 

Праймеры для 
мишени, зонд и 
деионизованная 

вода 

14,0 От 50 до 250 
нМ 

Общее количество 45,0 - 

Пример эксперимента 

Лунки содержат блокированный IPC и 
не содержат матрицу-мишень 

Лунки содержат IPC и не 
содержат матрицу-мишень 

Лунки содержат IPC и матрицу-мишень 

Образцы 
(неизвестные образцы + IPC) 

NAC NTС плюс IPC 
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2. В каждую лунку планшета добавить 
пипеткой по 45 мкл реакционной 
смеси. 

3. В каждую лунку 96-луночного 
планшета добавить пипеткой по 5 
мкл образца (NAC, NTC или 
неизвестного образца). 
Примечание:   Конечный объем 
реакционной смеси в каждой лунке 
должен составлять 50 мкл.  

4. До установки в прибор 7300/7500 
реакционный планшет следует 
хранить на льду. 

 

 

 

 
Для приготовления Добавить 

NACa 5 мкл смеси 10Х Exo 
IPC Block (IPC Kit) 
(набор IPC) 

NTCб 5 мкл буфера 1Х ТЕ 
или Н2О 

а. NAC � контроль в отсутствии 
амплификации, лунки не содержат матрицы-
мишени и содержащий блокированный IPC 

б. NTC � контроль в отсутствии матрицы, 
лунки содержат только IPC и не содержат 
матрицы-мишени. 

 

  

Для проведения эксперимента в каждую лунку 96-луночного планшета добавляют пипеткой по 45 
мкл реакционной смеси и 5 мкл соответствующего реагента, как указано в приведенной ниже 
таблице. 

Лунка Для приготовления Добавить в каждую лунку 

А1-А6 NAC 5 мкл смеси 10X Exo IPC Block 
(IPC kit) 

А7-А12 NTC 5 мкл  1Х ТЕ буфера или Н2О 

В1-Н12 Неизвестный образец (U)а 5 мкл образца ДНК 

а. Неизвестный образец � лунка содержит и матрицу мишень и IPC.  

 

Пример эксперимента 
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 Выполнение цикла анализа в 
режиме plus/minus до 

считывания 
Последовательность выполнения 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
Введение  

Глава 4 

 

Подготовка 
реакционного 
планшета 

Сбор данных 
амплификации 

Выполнение 
цикла Plus/minus 
после 
считывания 

Выполнение цикла до 
считывания См. стр. 25

 
Создание документа 
планшета plus/minus 

 

См. стр. 20

 

Определение 
параметров 
анализа в режиме 
Plus/Minus 

 

Выполнение цикла 
анализа в режиме 
Plus/Minus до 
считывания 

4 
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Цикл до считывания 
 При выполнении цикла до считывания данных регистрируется 

фоновый флуоресцентный сигнал каждой лунки реакционного 
планшета перед проведением ПЦР. При выполнении цикла после 
считывания значение флуоресцентного сигнала, полученное в цикле 
до считывания, вычитается из флуоресцентного сигнала , 
регистрируемого в цикле после считывания, что обеспечивает более 
высокую точность анализа. 

Перед началом анализа 
 Для того, чтобы обеспечить эффективность работы прибора 

7300/7500, необходимо регулярно определять сигнал фона и 
калибровать прибор с использованием индивидуальных красителей. 
Более подробная информация о калибровке прибора 7300/7500 
приведена на сайте оперативной помощи Online Help.  

Создание документа планшета plus/minus 
 Документ планшета plus/minus представляет собой документ 

программного обеспечения SDS, в котором сохраняют данные, 
собранные в процессе цикла plus/minus для одного 96-луночного 
планшета. В документах планшета Plus/Minus также хранится другая 
информация о цикле анализа, включая названия образцов и 
детекторов. 

Требования к 
документу 
планшета 

При создании нового документа планшета plus/minus с IPC следует 
определить параметры для каждого реакционного планшета 
plus/minus: 

• Detectors (Детекторы) - виртуальное представление в 
программном обеспечении SDS зонда TaqMan, набора 
праймеров и соответствующего флуоресцентного красителя, 
специфичного для определенной последовательности 
нуклеиновых кислот. Инструкции по определению детекторов 
приведены в приложении А. 

• Task (Тип детектирования) � параметр, применяемый для 
каждой лунки планшета, которая определяет тип анализа 
программным обеспечением SDS данных, собранных для 
каждой лунки. 
Примечание:   Фирма Applied Biosystems рекомендует 
использование шести репликатов каждого контроля (NAC и NTC) 
для определения пороговых значений при анализе в режиме 
plus/minus и получения откликов plus/minus с высокой точностью и 
регистрации откликов plus/minus с достоверностью 99.7%.  
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Типы 
детектирования 

Каждой лунке документа планшета приписывается тип 
детектирования. Для документа планшета анализа в режиме 
plus/minus используют четыре типа детектирования: 

Тип 
детектирования

Символ Характеристика 

Неизвестный 
образец 

 Все детекторы для лунок, содержащих 
анализируемые последовательности-
мишени. 

IPC  Все детекторы для лунок, содержащих 
IPC. 

IPC+  Все детекторы для контрольных 
лунок, содержащие IPC, но не 
содержащие матрицы-мишени. 

NTC  Все детекторы для лунок с 
отрицательным контролем, 
содержащие реагент для ПЦР, но не 
содержащие матрицы-мишени и IPC.  

 
Создание нового документа Plus/Minus Plate  
В новый документ о планшете можно ввести 
информацию об образце, импортировать 
информацию об образце из существующих 
документов о планшетах или использовать для 
создания нового документа о планшете документ 
о матрице. 

В данном разделе приведены инструкции по 
созданию новых документов о планшетах. 
Инструкции по импортированию информации об 
образце или использованию документов о 
матрице приведены на сайте оперативной 
помощи (Online Help). 

Для того чтобы создать новый документ 
plus/minus plate: 

1. Выбрать опцию Start > Programs > Applied  
Biosystems 7300/7500 > Applied Biosystems 
7300/7500 SDS Software ( ) и запустить 
программное обеспечение SDS. 

2. Выбрать опцию File > New (новый файл). 

3. В окне New Document wizard выбрать в 
ниспадающем меню Assay опцию 
Plus/Minus (анализ в режиме plus/minus). 
Для контейнера и матрицы (96-Well Clear и 
Blank Document) подтвердить заданные по 
умолчанию параметры. 

4. В поле Plate Name ввести Plus/Minus Pre-
Read. 

 

 

 

 

 

 

 

 

 

 

 

 
 

U

I

I+

N
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5. Нажать на клавишу Next > (следующее). 

6. Выбрать тип детектирования (детекторы) и 
включить их в документ о планшете. 

а. Чтобы выбрать детектор, нажать на 
название детектора (для выбора 
нескольких детекторов следует нажать 
на название и одновременно на 
клавишу Ctrl). Если в диалоговом окне 
не перечислено ни одного детектора, 
следует определить детекторы, как 
описано в приложении А � 
«Определение детекторов». 

б. Нажать на клавишу Add 
>>(добавить). В список используемых 
детекторов (Detectors in Document) 
будут включены выбранные 
детекторы. 
ВАЖНО:   Следует убедиться в том, что 
репортерный краситель для мишени 
отличается от репортерного красителя для 
IPC, которым является VIC. 

Примечание:   В наборе химических 
реактивов TaqMan Exogenous Internal 
Positive Control Reagents Kit (номер по 
каталогу 4308323) в качестве IPC 
используется зонд меченный красителем 
VIC и тушитель TAMRA. 

Примечание:   Для удаления детектора из 
списка Detectors (детекторы) в диалоговом 
окне Document (документ) следует 
выбрать название детектора и затем 
нажать на клавишу Remove (удалить.) 

с. Нажать на клавишу Next >.    

7. Выбрать шесть лунок в документе 
планшета для контроля в отсутствии 
амплификации (блокированный IPC в 
отсутствии матрицы-мишени). 

а. Выбрать лунки А1-А6. 

б. Выбрать детектор для мишени, 
отметив ячейку Use, расположенную 
рядом с соответствующим детектором. 

в. Выбрать опцию Task>NTC. В лунках 

 появится значок N. 

г. Выбрать детектор IPC, отметив 
ячейку Use, расположенную рядом с 
соответствующим детектором. 
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д. Выбрать опцию Task>NTC. В лунке 
появится второй значок N.  

8. Выбрать еще шесть лунок в документе 
планшета для контроля в отсутствии 
матрицы (IPC, но в отсутствии матрицы-
мишени) 

а. Выбрать лунки А7 � А12. 

б. Выбрать детектор для мишени, 
отметив ячейку Use, расположенную 
рядом с соответствующим 
детектором. 

в. Выбрать опцию Task>NTC. В 
лунках появится значок N. 

г. Выбрать детектор IPC, отметив 
ячейку Use, расположенную рядом с 
соответствующим детектором. 

д. Выбрать опцию Task>IPC+. В лунке 
появится значок I+. 

9.  Выбрать все оставшиеся ячейки для 
неизвестных образцов (в присутствии IPC и 
матрицы-мишени). 

а. Выбрать лунки В1 � Н12, нажав 
мышью и протянув курсор по всем 
пустым ячейкам. 

б. Выбрать детектор для мишени, 
отметив ячейку Use, расположенную 
рядом с соответствующим детектором. 

в. Выбрать опцию Task>Unknown. В 
выбранных лунках появляется значок 
U. 

г. Выбрать детектор IPC, отметив 
ячейку Use, расположенную рядом с 
соответствующим детектором. 

д. Выбрать опцию Task>IPC. Рядом со 
значком I появляется значок U. 

10. Нажать на клавишу Finish (завершить). 

11. Ввести названия образцов для каждой 
лунки. 

а.   Нажать на пиктограмму    или 
выбрать в меню опцию View > Well 
Inspector. 

б. Отметить мышью лунки для 
репликатов. 
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в. Ввести название образца. 

г. Подтвердить заданный по умолчанию 
(ROX) в качестве пассивного 
свидетеля краситель -ROX. 

д. Повторить стадии б-г, пока не будут 
указаны названия образцов для всех 
лунок планшета. 

е. Нажать на пиктограмму  , чтобы 
закрыть диалоговое окно Well 
Inspector. 
ВАЖНО!   Если в эксперименте 
используются не все лунки планшета, не 
следует пропускать неиспользуемые 
лунки на данном этапе. Их можно будет 
исключить после выполнения цикла. 
Более детальная информация об 
исключении неиспользуемых лунок 
приведена на сайте оперативной помощи 
(Online Help). 

Примечание:   Информация об образце 
(название образца, детектор, тип 
детектирования) могут быть изменены 
после завершения цикла. 

ж. Проверить информацию для каждой 
лунки в таблице Setup. 

 

 

 

  

Ниже на рисунке приведен документ планшета предварительного цикла, с заданными контролем и 
образцами. Для каждой лунки выбраны два типа детектирования, один для мишени и один для IPC. 
Возможны три комбинации: лунки, обозначенные как NN, соответствуют NAC (матрица - мишень 
отсутствует, добавлен блокированный IPC), лунки, обозначенные NI+ соответствуют NTC (матрица - 
мишень отсутствует, добавлен IPC), лунки, обозначенные UI соответствуют неизвестным образцам, 
содержащим IPC. 

 

 

Пример эксперимента 
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Выполнение цикла анализа до считывания 
1. Нажать клавишу Instrument. 

2. Подтвердить значения, заданные по 
умолчанию: 

• Объем образца � 50 мкл 

• Режим эмуляции � 9600 
Emulation. 

Примечание:   При работе на приборе 7300 
опция 9600 Emulation отсутствует. 

 

 

 

 

3. Выбрать опцию File > Save As 
(сохранить файл как), ввести название 
документа планшета Plus/Minus Pre-
Read, затем нажать на клавишу Save 
(сохранить). 

(Необязательно) Если созданный 
документ планшета предполагается 
использовать повторно, его можно 
сохранить в качестве шаблона. Для 
этого следует выбрать опцию File>Save 
As (сохранить файл как), ввести 
название файла в поле File Name, а 
затем выбрать Save As type (*.std). 

4. Установить планшет в приборе. 
Примечание: Планшет следует установить таким 
образом, чтобы лунка А1 была расположена в 
левом верхнем углу штатива прибора.  
 

5. Нажать на клавишу Pre-Read. 

Во время выполнения предварительного 
цикла прибор регистрирует один 
флуоресцентный сигнал в каждой 
ячейке. 

 

При выполнении цикла на экран в окне 
Instrument выводится информация о 
состоянии процесса (Status). После 
выполнения цикла информация о 
состоянии процесса и кнопки 

 

 
 

 
 

 
 

 

 

 

Лунка А1 

Срезанный 
угол 
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окрашиваются в серый цвет и 
появляется сообщение об успешно 
проведенном цикле или об ошибках, 
допущенных при выполнении цикла. 

6. Выбрать опцию File>Close. 
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 Сбор данных 

амплификации 

 
Последовательность выполнения 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
Введение  

Глава 5 

 

Подготовка 
реакционного 
планшета 

 

Сбор данных 
амплификации 

 

Выполнение 
цикла Plus/minus 
после считывания 

 
Запуск цикла 
амплификации 

 

См. стр. 32

 
Создание документа 
планшета plus/minus 

 

См. стр. 28

 

Определение 
параметров 
анализа в режиме 
Plus/Minus 

 

Выполнение 
цикла анализа в 
режиме 
Plus/Minus до 

5 
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Создание документа планшета для амплификации образца 
Преимущества 

амплификации в 
режиме 

реального 
времени 

Так как анализ в режиме plus/minus является анализом конечных 
данных, можно проводить амплификацию нуклеиновых кислот в 
любом термическом циклизаторе (не в режиме реального времени). 
Однако, использование прибора 7300/7500 для амплификации 
последовательностей - мишеней позволяет получить данные анализа 
plus/minus в режиме реального времени. Если обнаружены 
ошибочные отклики или данные для лунки отсутствуют, то после 
анализа образцов в режиме plus/minus можно просмотреть кривые 
амплификации. 

Использование 
документов 

планшета AQ 
для 

амплификации  

Документ планшета для абсолютного количественного анализа (AQ) 
создается для сохранения данных анализа plus/minus в реальном 
времени. Так как документ планшета AQ используется только для 
амплификации последовательности - мишени, а не для 
количественного анализа данных ПЦР, то для документа AQ не 
требуется получение стандартных кривых.  

Типы 
детектирования 

Для документа планшета AQ  при анализе используется три типа 
детекторов: 

Тип 
детектирования

Символ Характеристика лунок 

Неизвестный 
образец 

 Детекторы для лунок, содержащих 
анализируемые последовательности-
мишени. 

Стандарт  Детекторы для лунок, содержащих 
образцы с известным количеством 
нуклеиновой кислоты. 

NTC  Детекторы для лунок, содержащих 
отрицательный контроль, т.е. реагенты 
для ПЦР в отсутствии матрицы. 

Обозначение «неизвестный образец» используется и для IPC и для 
матрицы-мишени. 
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Для создания нового документа AQ Plate: 
1. Выбрать опцию Start > Programs > 

Applied Biosystems 7300/7500 > Applied 
Biosystems7300/7500 SDS Software 

( ) и запустить программное 
обеспечение SDS. 

2. Выбрать опцию File > New (новый 
файл). Открывается диалоговое окно 
New Document (новый документ).  

3. Выбрать в ниспадающем меню Assay 
(анализ) опцию Absolute 
Quantification(Standard Curve) 
(абсолютный количественный анализ 
(стандартная кривая)). Для контейнера и 
матрицы (96-Well Clear и Blank 
Document) подтвердить заданные по 
умолчанию параметры. 
Примечание:   Для проведения 
неколичественного цикла амплификации 
получение стандартной кривой не 
требуется.  

4. В поле Plate Name (название планшета) 
ввести Plus/Minus Amplification. 

5. Нажать на клавишу Next > (следующее). 
В окне New Document Wizard выводится 
список детекторов. 

6. Выбрать детекторы, которые 
необходимо включить в документ о 
планшете, и нажать на клавишу Add >> 
(добавить). 
ВАЖНО: Следует убедиться в том, что 
репортерный краситель для детектора 
мишени отличается от репортерного 
красителя для детектора IPC, которым 
является VIC. 

Примечание:   В наборе реактивов 
TaqMan Exogenous Internal Positive Control  
в качестве IPC используется зонд, меченный 
красителем VIC, и тушитель TAMRA.    

Примечание:   Для удаления детектора из 
списка Detectors (детекторы) в диалоговом 
окне Document (документ) следует выбрать 
название детектора и затем нажать на 
клавишу Remove (удалить.) 
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7.  Выбрать шесть лунок в документе 
планшета для контроля в отсутствии 
амплификации (блокированный IPC в 
отсутствии матрицы-мишени). 

а.  Выбрать лунки А1-А6. 

б.  Выбрать детектор для мишени, 
отметив ячейку Use, расположенную 
рядом с соответствующим 
детектором. 

в.  Выбрать опцию Task>NTC. В лунках 

появится значок N. 

г.  Выбрать детектор IPC, отметив 
ячейку Use, расположенную рядом с 
соответствующим детектором. 

д.  Выбрать опцию Task>NTC. В лунке 
появится второй значок N.  

8. Выбрать еще шесть лунок в документе 
планшета для контроля в отсутствии 
матрицы (IPC в отсутствии матрицы-
мишени) 

а. Выбрать лунки А7 � А12. 

б. Выбрать детектор для мишени, 
отметив ячейку Use, расположенную 
рядом с соответствующим 
детектором. 

в. Выбрать опцию Task>NTC. В 
лунках появится значок N. 

г. Выбрать детектор IPC, отметив 
ячейку Use, расположенную рядом с 
соответствующим детектором. 

д. Выбрать опцию Task>Unknown. В 
выбранных лунках появляется 
значок U рядом со знаком N. 

9. Выбрать все оставшиеся ячейки для 
неизвестных образцов (в присутствии 
IPC и матрицы-мишени). 

а. Выбрать лунки В1 � Н12, нажав 
мышью и протянув курсор по всем 
пустым ячейкам. 

б. Выбрать детектор для мишени 
(Target), отметив ячейку Use, 
расположенную рядом с 
соответствующим детектором. 
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в. Выбрать опцию Task>Unknown. В 
выбранных лунках появляется 
значок U. 

г. Выбрать детектор IPC, отметив 
ячейку Use, расположенную рядом с 
соответствующим детектором. 

д. Выбрать опцию Task>Unknown. 
Рядом со значком  U мишени 
появляется еще один значок U. 

10. Нажать на клавишу Finish (завершить). 

Программное обеспечение прибора 
7300/7500 создает документ планшета. 

11. Ввести названия образцов для каждой 
лунки. 

а.   Дважды нажать мышью на 
соответствующую лунку, чтобы 
открыть окно Well Inspector или 
выбрать в меню опцию View > 
Well Inspector. 

б.   Отметить мышью лунки для 
репликатов. 

в.   Ввести названия образцов в поле 
Well Inspector. Информация о 
названии отображается в 
выбранной лунке. 

г.   Подтвердить заданный по 
умолчанию (ROX) в качестве 
пассивного свидетеля краситель -
ROX. По выбору можно изменить 
тип детектора и пассивный 
свидетель. 

д.   Повторить стадии б-г, пока не 
будут указаны названия образцов 
для всех лунок планшета. 

е.  Нажать на пиктограмму , чтобы 
закрыть диалоговое окно Well 
Inspector. 

 
ВАЖНО!   Если в эксперименте 
используются не все лунки планшета, 
не следует пропускать 
неиспользуемые лунки на данном 
этапе. Их можно будет исключить 
после выполнения цикла. Более 
детальная информация об исключении 
неиспользуемых лунок приведена на 
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сайте оперативной помощи (Online 
Help). 

ж.    Проверить информацию для каждой 
лунки, нажав на кнопку Setup в 
окне Setup. 

Запуск цикла амплификации 
1. Нажать на кнопку Instrument. 

По умолчанию для стадии ПЦР заданы 
стандартные условия. 

 
Значения времени и температуры (двухстадийный метод ОТ-ПЦР) 

Начальные стадии ПЦР (для каждой серии из 40 циклов) 

Активация 
фермента AmpErase 

UNG 

Активация ДНК 
полимеразы 

AmpliTaq Gold DNA 
Polymerase 

Плавление Отжиг/наращивание 
цепи 

HOLD 

(инкубация) 

HOLD 

(инкубация) 

CYCLE 

(цикл) 

CYCLE 

(цикл) 

2 мин @ 50oC 10 мин @ 95oC 15 c @ 95oC 1 мин @ 60oC 

2. Подтвердить заданные по умолчанию 
значения: 

• Объем образца � 50 мкл 

• Режим эмуляции � 9600 Emulation 
Примечание:   При работе на приборе 7300 
опция 9600 Emulation отсутствует. 

3. Выбрать опцию File > Save As (сохранить 
файл как), затем нажать клавишу Save, 
чтобы сохранить название документа 
планшета. 

4. Установить планшет в приборе. 
Примечание: Планшет следует установить 
таким образом, чтобы лунка А1 была 
расположена в левом верхнем углу штатива 
прибора. 

5.   Нажать на клавишу Start. 

 

 

Лунка А1 

Срезанный 
угол 



Руководство по подготовке к выполнению анализа в режиме Plus/Minus на приборе 7300/7500          33

При выполнении цикла ПЦР на экран в 
окне Instrument выводится информация о 
состоянии процесса (Status) в реальное 
время и регистрируется флуоресцентный 
сигнал от расщепления зонда TaqMan в 
присутствии последовательности - 
мишени. 

После выполнения цикла информация о 
состоянии процесса и кнопки 
окрашиваются в серый цвет, становится 
доступной функциональная клавиша 
Analysis ( ), и появляется сообщение об 
успешно проведенном цикле или об 
ошибках, допущенных при выполнении 
цикла. 

Все данные, собранные в процессе 
выполнения цикла, сохраняются в 
документе планшета, который создан 
пользователем, как указано в п. 3, и могут 
быть проанализированы в дальнейшем в 
случае обнаружения ошибок. 

6.   Для просмотра данных ПЦР в реальном 
времени после завершения выполнения 
цикла, следует нажать на пиктограмму 

Analysis , выбрать кнопку Results, 
выбрать кнопку Amplification Plot, а затем 
выбрать все лунки планшета в левом 
верхнем квадрате (рядом с лункой А1).  

Примечание:   Параметры образца и 
условия анализа (название образца, тип 
детектирования) могут быть изменены 
после завершения цикла. 
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 Выполнение цикла анализа в 
режиме plus/minus после 
считывания результатов 

Последовательность выполнения 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Глава 6 

 

 
 
Введение  

 

Подготовка 
реакционного 
планшета 

Сбор данных 
амплификации 

Выполнение цикла 
Plus/minus после 
считывания 

Экспортирование 
данных из документа 
планшета plus/minus 

См. стр. 40

 
Выполнение анализа 
после считывания 
результатов 

См. стр. 35

 

Определение 
параметров 
анализа в 
режиме 

 

Выполнение 
цикла анализа в 
режиме 
Plus/Minus до 
считывания

6 

Просмотр результатов 
анализа в режиме 

plus/minus 
См. стр. 36
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Выполнение анализа после считывания результатов 
Открыть документ планшета анализа до считывания. 

1. Нажать на кнопку Instrument. 
 

2. Подтвердить заданные по умолчанию 
значения: 

• Объем образца 50 мкл 

• Режим эмуляции 9600 Emulation. 
Примечание:   При работе на приборе 7300 
опция 9600 Emulation отсутствует. 

 

3.  Выбрать опцию File > Save As (сохранить 
файл как), ввести название документа 
планшета анализа plus/minus - Plus/Minus 
Post-Read, затем нажать на клавишу Save 
(сохранить). 

 

 

 

 

 

4. Установить планшет в прибор. 
Примечание: Планшет следует установить таким 
образом, чтобы лунка А1 была расположена в 
левом верхнем углу штатива прибора.  
 

 

5. Нажать на клавишу Post-Read. 

После выполнения цикла информация о 
состоянии процесса и кнопки окрашиваются 
в серый цвет, появляется сообщение об 
успешно проведенном цикле или об 
ошибках, допущенных при выполнении 
цикла. 

6. Для того, чтобы начать анализ, следует 
нажать зеленую кнопку ( ). 

Все данные, полученные в процессе 
выполнения цикла, сохраняются в документе 
планшета plus/minus, который создан 
пользователем, как указано в п. 3. 

 

 

 

 
 

 

 

 

 

 

 

 

Лунка А1 

Срезанный 
угол 
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В эксперименте в режиме plus/minus с использованием IPC фоновый сигнал, полученный до 
считывания, вычитается из сигнала, полученного после считывания. Результаты анализа на 
присутствие ДНК из E. coli после считывания  выводятся в окне Results>Plate Tab. Описание 
результатов приведено в разделе «Просмотр результатов анализа в режиме Plus/Minus» на стр. . 

 
 

Просмотр результатов анализа  в режиме plus/minus 
Результаты После завершения анализа в режиме plus/minus после считывания 

программное обеспечение SDS сравнивает спектральные данные, 
полученные в лунках с неизвестными образцами и  контролями, 
обозначенными ранее как NAC и NTC. Пороговое значение для NAC 
рассчитывается по данным в лунке с контролем NAC, пороговое 
значение для IPC+ - по данным в лунке с контролем NTC. Пороговое 
значение IPC+ используется при расчете данных амплификации 
мишени - нуклеиновой кислоты в неизвестных образцах в каждой 
лунке. Пороговое значение NAC используется для расчета 
амплификации IPC в каждой лунке с неизвестным образцом.  

Считывание 
результатов, 
полученных в 

лунках с 
неизвестными 
образцами с 

использованием 
IPC 

Для считывания сигнала в лунках с неизвестными образцами с 
использованием IPC программное обеспечение SDS сравнивает 
нормализованный сигнал репортерной группы каждого неизвестного 
образца с пороговым значением для IPC+ и NAC.  Результаты 
считываются следующим образом: 

• Если сигнал мишени неизвестного образца превышает 
пороговое значение для IPC+, результат считается 
положительным (+). 

• Если сигнал мишени неизвестного образца не превышает 
пороговое значение для IPC+, программное обеспечение SDS 
сравнивает сигнал мишени неизвестного образца со пороговым 
значением для NAC следующим образом: 

- Если сигнал равен или ниже порогового значения NAC, 

Пример эксперимента 
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результат считается отрицательным (-). 

- Если сигнал больше порогового значения NAC, 
результат считается неопределенным (?). 

 

Окно Plate (Планшет) 
После завершения анализа после считывания, для 
вывода на экран конечных результатов анализа в 
режиме plus/minus на наличие или отсутствие 
мишени - ДНК в каждой лунке, следует нажать на 
кнопку Plate (планшет) в окне Results (результаты). 

В показанном  ниже примере эксперимента в 
соответствующих окнах показаны графики 
амплификации для каждого вида результатов (NAC, 
NTC, plus (+), minus (-) и определенные результаты. 
Примечание:   Графики амплификации получены из 
документа AQ Plate, который использовался для 
проведения амплификации образцов в 96-луночном 
планшете. 

 

 

 

  

На приведенном ниже рисунке показан график амплификации для лунки А1, в которую был добавлен 
контроль в отсутствии амплификации (NAC), блокированный IPC и контроль в отсутствии матрицы -
мишени. На графике видно, что амплификации для IPC и  ДНК из E. coli не наблюдается. 

                                                   
 

 

 

 

 

Пример эксперимента 

ДНК E. coli отсутствует

Блокированный IPC, 
амплификация  не происходит 

Лунка А1 
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На приведенном ниже рисунке показан график амплификации для лунки А10, в которую был 
добавлен контроль в отсутствии матрицы (NTC), IPC и не добавлена матрица -мишень. На графике 
видно, что наблюдается положительная амплификация для IPC и не наблюдается амплификации для 
ДНК из E. coli. 

                                          
 

 

 

  

На приведенном ниже рисунке показан график амплификации неизвестного образца для лунки D2, в 
которой получен отрицательный результат (-). Результат признан отрицательным, так как сигнал 
амплификации мишени E. coli меньше, чем сигнал NAC. Положительная амплификация IPC 
свидетельствует о том, что ПЦР в данной лунке происходит эффективно. 

                               
 

 

 

 

 

 

Пример эксперимента 

IPC+ 

E. coli отсутствует

Лунка А10 

Пример эксперимента 

IPC 

E. coli отсутствует

Лунка D7 
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На приведенном ниже рисунке показан график амплификации неизвестного образца для лунки F1, в 
которой получен положительный результат (+). Результат для ДНК - мишени E. coli признан 
положительным, так как сигнал амплификации в лунке выше порогового значения IPC. 

                                                       
 

 

 

 

  

На приведенном ниже рисунке показан график амплификации неизвестного образца для лунки В9, в 
которой получен неопределенный результат (?). Результат отмечен вопросительным знаком (?), так 
как пороговое значение мишени образца ниже порогового значения IPC, но выше сигнала NAC. 

                                           
 

 
Примечание:   Более подробную информацию об анализе данных амплификации и полученных 
результатах анализа в режиме plus/minus см. в приложении В в разделе «Просмотр данных 
амплификации». 

 

 

 

Пример эксперимента 

IPC 
E. coli  

Лунка F1 

Пример эксперимента 

IPC 

E. coli

Лунка В9 

E. coli

IPC 
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 Экспортирование данных из документа планшета plus/minus 
Числовые данные из документов Plus/Minus plate 
могут быть экспортированы в текстовые файлы, 
которые затем могут быть импортированы в 
табличные файлы, например в программе 
Microsoft Excel. 

1. Выбрать опцию File>Export, затем выбрать 
тип данных, которые необходимо 
экспортировать: 

• Sample Setup (*.txt) 
• Calibration data (*.csv) 
• Spectra (*.csv) 
• Component (*.csv) 
• Rn (*.csv) 

Информацию об экспортировании файлов 
можно найти на сайте оперативной помощи 
Online Help. 

2. Ввести название экспортируемого файла. 
Примечание:   Название диалогового окна 
зависит от типа экспортируемых данных. 

3. Нажать Save (сохранить). 
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Определение детекторов    А 
Перед использованием документа о планшете для 
запуска цикла анализа необходимо создать и 
определить тип детектора для всех образцов в  
планшете. Детектор является виртуальным 
представлением меченного красителем зонда, 
специфичного для определенного гена или аллеля, 
который будет использоваться для анализа. 
Для определения детектора: 

1. Выбрать опцию Tools>Detector Manager. 
Примечание:   Для доступа в меню Tools должен 
быть открыт документ о планшете любого типа. 

2. Выбрать опцию File>New. 
 
 
 
 
 
 
 
 
 
 

3. Ввести название детектора. 
ВАЖНО!   Название детектора должно быть 
оригинальным и отражать локус мишени, 
предназначенной для анализа (например, IPC или 
E. coli). Нельзя использовать одно и то же 
название для разных детекторов. 

4. При необходимости можно нажать на поле 
Description, а  затем ввести краткое описание 
детектора. 

5. В ниспадающем меню Reporter Dye 
(репортерный краситель) и  Quencher Dye 
(краситель-тушитель) выбрать 
соответствующие красители для детекторов. 
Примечание:   В списках Reporter Dye и Quencher 
Dye перечислены названия красителей, которые 
были предварительно введены с использованием 
меню Dye Manager. Если название красителя, 
который требуется использовать, отсутствует в 
списке, необходимо ввести его через меню Dye 
Manager, а затем вернуться к выполнению стадии 
5 данной методики. Более подробная информация 
приведена на сайте оперативной помощи Online 
Help. 
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6. Нажать на ячейку Color и выбрать цвет для 
представления детектора с использованием 
диалогового окна Color, нажать ОК. 

7. При необходимости выбрать поле Notes и 
ввести дополнительные примечания о 
детекторе. 

8. Нажать ОК,  чтобы сохранить детектор и 
вернуться в меню Detector Manager. 

9. Повторить стадии 2-8 для остальных 
детекторов. 

10. После завершения определения детекторов 
нажать Done в меню Detector Manager. 

 
  
 
В примере эксперимента анализа в режиме plus/minus один детектор создан для мишени E. coli , а 
другой � для стандарта IPC. Детектору мишени E. coli приписан синий цвет, а детектору стандарта 
IPC � черный. 
 
Примечание:   При создании детекторов используется информация о репортерном красителе и 
красителе-тушителе (и, по выбору, название гена или символ для названия образца). Содержание 
можно посмотреть в табличной программе, например в программе Microsoft Excel. 

Пример проведения эксперимента 
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Просмотр данных амплификации    В 
 
Конфигурирование параметров анализа 
 
Перед запуском анализа данных необходимо задать 
параметры для автоматического расчета базовой 
линии и порогового значения сигнала.  
Не смотря на то, что в данном эксперименте 
пользователь уже установил параметры 
оптимальной базовой линии и значения порогового 
сигнала, следует проанализировать данные дважды: 
первый раз с использованием автоматически 
установленных программным обеспечением SDS 
базовой линии и порогового значения сигнала (Auto 
CT) и повторно после определения оптимальных 
базовой линии и порогового значения сигнала для 
анализируемых данных. 
Для конфигурирования параметров анализа: 

1. Нажать на пиктограмму или выбрать            
Analysis> Analysis Setting. 

2. В ниспадающем меню Detectors выбрать 
опцию All (все пункты). 

3. Выбрать опцию Auto Ct. Программное 
обеспечение SDS автоматически 
устанавливает базовую линию и пороговое 
значение сигнала для каждой лунки. 
ВАЖНО!   После выполнения анализа 
необходимо убедиться в том, что проверка 
базовой линии и порогового значения сигнала 
прошла успешно для каждой лунки.  В другом 
варианте можно выбрать пункт меню Manual CТ 
(установка CТ вручную) и установить базовую 
линию и пороговое значение сигнала вручную. 
Более подробная информация об установке CТ 
вручную приведена на сайте оперативной 
помощи OnlineHelp. 
 

4. Если необходимо использовать 
калибровочные файлы (Background (фон) и 
Pure dye (чистые красители)), которые 
хранятся в памяти компьютера, в отличие от 
калибровочной информации, хранящейся в 
файле о планшете, следует выбрать опцию 
Use System Calibration (выбор калибровки 
системы). 
Подробная информация о калибровочных 
файлах системы приведена на сайте 
оперативной помощи Online Help. 

5. Нажать на клавишу OK&Reanalyze (ОК и 
повторный анализ). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

 
 
 

Сайт оперативной  
помощи  Online Help 
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Анализ данных амплификации plus/minus (документ AQ Plate) 
 

Термины, 
используемые 

при проведении 
количественного 

анализа 

Ниже приведены термины, которые обычно используются в 
количественном анализе: 

Термин Определение 

Базовая линия Линия, соответствующая интенсивности 
флуоресценции в начальных циклах ПЦР, при 
этом наблюдаются лишь незначительные 
изменения флуоресцентного сигнала. 

Пороговый цикл (Ст) Номер цикла, при котором величина 
флуоресценции превышает пороговое значение. 

Пассивный 
свидетель 

Краситель, являющийся внутренним 
флуоресцентным свидетелем, по которому 
нормализуется сигнал репортерного красителя в 
процессе анализа данных. Нормализация 
необходима для корректировки изменений 
флуоресцентного сигнала, связанных с 
изменениями концентрации или объема. 

Репортерный 
краситель 

Краситель, присоединенный в 5� положении 
зонда TagMan. Краситель обеспечивает сигнал 
флуоресценции, который возникает при 
специфической амплификации. 

Нормализованный 
репортер (Rn) 

Отношение сигнала флуоресценции репортерного 
красителя к сигналу флуоресценции красителя, 
используемого в качестве пассивного свидетеля. 

Дельта Rn (∆Rn) Величина сигнала, регистрируемого при 
заданных условиях проведения ПЦР (∆Rn =Rn � 
значение базовой линии). 

 

На следующем рисунке приведен пример кривой амплификации ДНК 
и некоторые из определенных выше терминов. 

 
 

 
 

Номер цикла

Базовая линия

Пороговое значение 
сигнала 

Образец

Контроль в отсутствии 
 матрицы 
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Запуск анализа Для запуска анализа данных амплификации (AQ Plate), нажать на 

пиктограмму   или выбрать опцию Analysis>Analyze. 
Программное обеспечение создает несколько видов представления 
результатов, как описано в следующем разделе. 

 
Просмотр данных амплификации 
 
Диалоговое окно Results (Результаты) 
В диалоговом окне Results можно посматривать 
результаты цикла амплификации и изменять 
параметры для повторного запуска цикла 
планшета или повторного анализа данных. 
Диалоговое окно Results содержит семь 
вторичных окон, каждое из которых описано 
ниже. Более подробная информация приведена на 
сайте оперативной помощи Online Help. 
 
Диалоговое окно Plate (планшет) 
В окне отображены полученные результаты для 
каждой лунки, включая: 

• Название образца, заданный детектор и 
цвет для каждой лунки 

• Рассчитанное значение � количество (по 
умолчанию, количество не определяется 
для циклов без стандартных кривых), ∆Rn, 
или CТ. Чтобы выбрать значение для 
вывода на экран, следует выбрать опцию 
Analysis>Display 

 
Диалоговое окно Spectra (спектры) 
В окне отображены спектры флуоресценции в 
выбранных лунках. 

• Cycles slider (полоса прокрутки) позволяет 
просматривать спектры для каждого цикла, 
перемещая курсор от цикла к циклу. 

• В ячейке Сycle # указано текущее 
положение курсора на поле прокрутки. 

С помощью двойного нажатия на ось у можно 
открыть диалоговое окно Graph Settings 
(параметры графика), в котором можно изменить 
параметры осей х или у или задать автоматическое 
определение масштаба. 
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Диалоговое окно Component (компонент) 
В окне отображен полный спектральный вклад 
каждого красителя в сигнал, полученный в 
выбранной лунке в течение цикла ПЦР. В одно и 
то же время могут быть отображены данные 
только в первой из выбранных лунок. 
Дважды нажав на ось у можно открыть 
диалоговое окно Graph Settings (параметры 
графика). 
 
Диалоговое окно Amplification Plot 
(график амплификации) 
Три вида графиков амплификации позволяют 
просмотреть результаты амплификации 
определенных образцов как в реальном времени, 
так и результаты амплификации после 
считывания. На экране отображаются графики 
для всех образцов в выбранных лунках. 
 
 
График зависимости Rn � Cycle 
(линейный) 
Отображает нормализованный флуоресцентный 
сигнал  репортерного красителя (Rn) в 
зависимости от номера цикла. Данный вид 
графика используют для выявления необычных 
циклов амплификации. 
Более подробная информация о  величине Rn 
приведена в руководстве SDS Chemistry Guide 
(номер по каталогу 4348358). 
 
График зависимости ∆ Rn � Cycle 
(логарифмический) 
Отображает флуоресцентный сигнал (Rn) в 
зависимости от номера цикла. Данный вид 
графика используют для выявления и 
исследования необычных циклов амплификации 
и для установки вручную порогового значения и 
базовой линии цикла. 
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График Ct � позиция лунки 
Отображает пороговый цикл (Сt) в зависимости 
от расположения лунки. Данный график 
используют для выявления и исключения 
ошибочных результатов (outliers) в наборе 
данных по детекторам. 

 
 
Диалоговое окно  Report (Отчет) 
Отображает данные для выбранных лунок в виде 
таблицы. Столбцы таблицы зависят от заданного 
типа анализа. Для анализов plus/minus в таблице 
указаны следующие параметры: лунка, название 
образца, детектор, тип детектирования, CТ и 
StdDev (стандартное отклонение) величины Ct. 
Пользователь может форматировать вид отчета и 
форму, в которой он будет распечатан. Более 
подробная информация об этом диалоговом окне 
приведена на сайте оперативной помощи 
OnlineHelp. 

 

 
 
 

 

Регулировка параметров графика 
Нажатие на ячейки Spectra (cпектры), Component 
(компонент), Amplification Plot  (график 
амплификации), Standard Curve (стандартная 
кривая) и Graph Settings (параметры графика) 
позволяет пользователю устанавливать 
параметры графика. 

Параметры, которые пользователь может 
изменить, зависят от типа просматриваемого 
графика. Боле подробная информация приведена 
на сайте оперативной помощи Online Help.  
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 Просмотр результатов анализа 
Для просмотра обнаруженных положительных 
или отрицательных откликов, обозначающих 
наличие или отсутствие последовательности - 
мишени в каждой лунке, следует выбрать 
диалоговое окно Results (результаты). Для 
дальнейшего анализа результатов следует 
выбрать графики для каждой лунки. 
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